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	�Xactimate 28 Certification Prep Overview and Preparation

Certification Exam Overview

If you are a professional working in the construction and insurance repair industry, you understand how 
important it is to have an accurate repair estimate. That’s why Xactware created the Xactimate certification 
program: to help you ensure that every Xactimate user has the knowledge and skills needed to accurately 
create an estimate in Xactimate.

The Xactware certification program has rigorous training and testing requirements for each level of 
certification. As a result, you can trust that those certified by Xactware are the best in the business.

Whether your goal is to become an Xactimate-certified user or an Xactimate-certified trainer, completing the 
Xactware Certification Program places you in an elite group of Xactware professionals. Demonstrate your 
Xactimate expertise by joining the many other Xactimate certified users.

Recommended Preparation

  Classroom Training: Attend an Xactimate 28 Training Class  
Xactimate 28 training classes are offered in a variety of convenient forms, including self-paced, virtual 
classroom (online), and classroom formats. Visit www.xactware.com/training for more details on class 
availability.

  Review the Xactimate 28 Training Workbook 
 

This 295-page workbook is a great resource to help prepare for the Level 2 Certification exam. Visit 
www.xactware.com/store to order a copy.

  Virtual Classroom Training: Certification Preparation Course  
This two-hour refresher course helps prepare an individual for the exam. Class participants will be 
instructed individually by Xactware Certified Trainers. Visit us at www.xactware.com to schedule a class.

Certification Benefits

Benefits of being a certified Xactimate user include:

  marketing yourself as one of the best Xactimate users in the business
  giving employers confidence that you are a certified Level 2 Xactimate user
  having the opportunity to be listed in the User Certification Directory
  receiving a Level 2 certificate

User Certification

Xactware currently offers three levels of user certification for Xactimate in order to independently verify a 
user’s product knowledge and proficiency. Because each level of certification increases in difficulty, it is  
recommended to take the exams in order as a preparation for the next level. The certification levels include:

  Level 1 Certification: Xactimate Fundamentals 
 

This level of certification verifies that a user has the foundational skills required to create an estimate from 
start to finish in Xactimate.
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  Level 2 Certification: Xactimate Proficiency (Power User)  
This level confirms that a user has mastered the foundational Xactimate concepts and can use more 
intermediate Xactimate practices to increase their productivity, efficiency, and accuracy.

  Level 3 Certification: Xactimate Mastery (Subject Matter Expert)  
This level validates that the user has full mastery of Xactimate and can be considered an Xactimate 
subject matter expert.

To obtain certification, users must complete a three-part program at each level that consists of:

  Practical hands-on lab—users must create an estimate based on a specific Sketch and scope scenario. 
This portion of the Certification exam is NOT timed.

  Practical exam—users are asked questions pertaining to the estimate created in the practical lab. This 
portion of the Certification exam is timed.

  Knowledge exam—consists of multiple choice, true/false, and matching questions. This portion of the 
Certification exam is timed.

Trainer Certification

The Xactware Certified Trainer (XCT) program is for organizations teaching students how to use Xactimate 
and want to have an edge on their competition. 

XCTs can provide the same level of training a user would receive at Xactware’s headquarters. Certified 
Trainers have direct access to the online training center and the extensive Resource Library of training 
material as well as other resources. This path is recommended for organizations generating revenue from 
Xactimate training courses.

This rigorous and comprehensive certification program is designed for trainers who want to train others on 
Xactimate. Those who complete the requirements are granted the elite status of XCT.

Once certified, XCTs have the privilege of providing authorized Xactimate training while being promoted by 
Xactware. Being trained by an XCT is equivalent to being trained at Xactware’s campus. This high caliber of 
training assures employers and those seeking to be trained on Xactimate that they will be properly trained. 

  Xactware Certified Trainer requires you to take the following steps: 

• Register for the Certified Trainer program by calling (800) 232-9228 Ext. 723
• Sign and return the Xactware Training Services Agreement
• Pass the Xactimate Level 3 Certification Exam
• Complete the three-day Train-the-Trainer course
• Pass the Xactware Trainer Exam
• Conduct Xactimate Training while being observed by Xactware personnel
• Pass the Xactimate Training Evaluation
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	�Level 2 Certification Prep Exam—Xactimate Proficiency

The certification exam for Xactimate Proficiency verifies that the user has the foundational skills required to 
create an estimate from start to finish using Xactimate 28.

Certification Exam Components

This exam is broken into three different sections. The three sections are as follows:

  Sketch and Scope Lab: In this hands-on lab, individuals are required to use their own locally installed 
Xactimate (or online version) to create an estimate. The most recent version of Xactimate 28 is 
required. The estimate consists of a Sketch and scope scenario that must be completed accurately. The 
estimate will be used to answer the questions found in the Practical Exam section. The Sketch and Scope 
labs are not timed, and individuals may exit and return to the lab as needed prior to beginning the 
Practical Exam and Knowledge Exam.  
*The approximate time required to complete this section is 60-120 minutes.
Note: By default, Sketch rounds to the nearest inch, which may cause a slight variance in your measurements. 
The exam has been structured to allow for a minor variance in calculating quantities.

  Practical Exam: In this section of the exam, individuals are asked 35 questions pertaining to 
the estimate created in the Sketch and Scope labs. Questions are specific to the scope, quantities, 
dimensions, and pricing from the estimate. This section of the exam is timed. Closing the Practical Exam 
prior to completion will result in an automatic FAIL.  
*The approximate time required to complete this section is 30-90 minutes.

  Knowledge Exam: This portion of the exam consists of 35 multiple-choice, true/false, and matching 
questions. Questions are related to the learning objectives listed below in the Knowledge Requirements 
section of this document. This section of the exam is timed. Closing the Knowledge Exam prior to 
completion will result in an automatic FAIL.  
*The approximate time required to complete this section is 30-90 minutes.

Passing grade is 70%. The time limit for the Practical Exam and Knowledge Exam is 180 minutes.

A scoring breakdown will be available upon completing the exam. It provides details for performance on each 
area of the exam.

Knowledge Requirements/Learning Objectives

Individuals will be required to demonstrate that the following learning objectives have been met:

  The user demonstrates understanding of Claim Info, Contact Manager/Import from Contacts, 
Parameters, Depreciation Options, Tokens, Opening and Closing Statements.

  The user demonstrates understanding of Room Properties, Relation to Level, Ceiling Type, Orientation 
Tool, Sketch Staircases, Square Break Tool (click+drag method), Vertex Tool, Wall Tool, Reference Areas 
and Blocks, Missing Wall, and Room Variables LL, HH, SH, V.

  The user demonstrates understanding of Multiple Levels, Level Properties, Sketch Options 
(measurements, font size, reset window views, keyboard shortcuts), Sketch Images Window/Add/Load 
Digital Images, Sketch Image Reference, Annotation Ribbon.
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  The user demonstrates understanding of Grouping Members (Append, Insert, Attach), Quick Entry, 
Search for Line Items, Retrieve Scope, Coverage Association, Depreciation Options, Dwelling Coverages, 
Activity Information, Miscellaneous Items, Line Item Attachments, Subvariables/Calculations, Calculate 
Waste (F*1.15), and the Global Changes Wizard.

  The user demonstrates understanding of Estimating from Sketch, Estimating Windows, Searching for 
Line Items, Selecting Surface Areas, Adding Items Graphically, Floor Covering Tools, and Sketch Items 
List.

  The user demonstrates understanding of Estimate Items Window, Quick Entry Method, Quick Entry 
Navigation, and Column identification.

  The user demonstrates understanding of Estimating in Sketch, Item Information Window, Common 
Roofing Materials, Adding Roofing Line Items in Sketch, Calculating Waste for Roofing Shingles, and 
Manually Calculating Waste SQ*1.15.

  The user demonstrates understanding of Locking/Unlocking Roof Measurements, Roof Properties (Roof 
Rafters, Ridge, Span), Multiple Roof Slopes and Shapes, Roof Overbuilds, Commercial Roof Shapes, and 
Roof Variables VAL, HIP, EAVE, RAKE.

  The user demonstrates understanding of Elevation Grouping Member, Dimensioning an Elevation, 
Adding Line Items to Grouping Members, Variables Association, and Reference Search on Exterior.

  The user demonstrates understanding of Change Estimate Status from In Progress to Completed, 
Complete, Submit Required Information, Correct Inspection Violations, Mark Estimate Completed, 
Print Report, and Upload Assignment.

  The user demonstrates understanding of Project Preview, Duplicating/Copying Projects, Quick Copy, 
Merge Projects, Save and Save As, Resequence Line Numbers, Recycle Bin, and Project Defaults.

  The user demonstrates understanding of Download Historical Price Lists, Provide Pricing Feedback, 
Components, Supporting Events, Labor Minimums vs. Base Service Charges, and Price Changes.

  The user demonstrates understanding of Creating Macros, Retrieving Macros, Pre-built Macros in 
Sketch, and Sketch Templates (use existing, rotate, flip).

  The user demonstrates understanding of Data Transfer types, such as projects, price lists, company 
headers, model statements, contacts, and references; Version Compatibility, Transfer Type: Folder, 
XactAnalysis, Cloud, can drag and drop (send) data, and can choose to skip, merge/rename, or overwrite 
items.

  The user demonstrates understanding of Print Reports, Estimate Reports, Info Tab, Print Options, 
Line Item Detail, Sketch Images, Claim Reports, Documents, Report Macros, Uploaded Documents, 
Additional Options, Language Selection, Take-off Reports, and Print Images on Report. 

You may now proceed to the 
Level 2 Certification Prep Exam beginning on the next page.
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	�Certification Prep Exam Instructions

Introduction

This section contains the instructions for the Level 2 Certification prep exam.

You must have the most recent version of Xactimate available during the exam. Upon completing the exam, 
you can check your answers in the Answer Key Appendix at the back of this book.

Recommended Order for Taking the Exam

We recommend that you take the exam sections in the following order: 

  Practical Lab: you will create two estimates in Xactimate—one interior estimate and one roof estimate—
that will be used to answer the questions in the Practical Exam. These estimates include a sketch and an 
estimate scope.

  Practical Exam: you will be required to answer 35 questions. The questions will be based on the estimate 
that you create in the Practical Lab.

  Knowledge Exam: you will be required to answer 35 matching, true/false, and multiple choice questions 
that test your knowledge of Xactimate.

Remember: When you are taking the actual certification exam (instead of this prep exam), the system 
automatically signs you out after 30 minutes of inactivity. You will have three continuous hours to complete 
both the Practical Exam and the Knowledge Exam sections. If you exit the exam prior to finishing the exam, 
it will be marked as FAILED. 

This prep exam allows you to take as much time as necessary to complete it. 

Practical Lab (Sketch and Scope)

You must complete this Practical Lab prior to starting the Practical Exam portion of this test. 

In this lab, you will create a new estimate and complete the corresponding sketch and scope. The estimate 
should be created using your own locally installed Xactimate. Later in the Practical Exam, you will answer a 
series of questions pertaining to the estimate.

Once you have completed the lab, proceed to the Practical Exam. It is extremely important that you 
accurately complete the lab estimate prior to beginning the Practical Exam. When you are taking the actual 
certification exam, you will not be able to see the Practical Lab instructions once you begin the Practical 
Exam; you will be solely reliant on the estimate that you created in Xactimate to answer the questions. 

Be sure to pay close attention to each of the instructions.

Sketch Lab

  In this Lab, you will create a new estimate and complete the diagram in Sketch. Try and complete the 
Lab in its entirety before moving on to the Scope Lab. The actual online exam will not let you revisit the 
Sketch Lab once you have moved beyond it.

  Use the latest version of Xactimate.
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	�Practical Lab—Sketch

Kimball Sketch

Instructions: For the interior estimate, open a new project in Xactimate and name it KIMBALL, followed 
by your initials; for example, KIMBALL-JMS. Go directly to Sketch. If prompted, choose the UTOR8X_
AUG13 price list. Pay close attention to the room details and notes found on the Sketch diagram and follow 
these directions.

  Leave all Sketch properties at the default setting unless otherwise specified.
  All walls are 4" thick.
  Ceiling height is 8' unless otherwise specified.
  All doors are default 2'6" x 6'8" Standard unless otherwise specified.
  All doors have the Deduct Opening property set to No unless otherwise specified.
  All windows are default 5' x 4' Picture unless otherwise specified.
  All windows have the Deduct Opening property set to No unless otherwise specified.

Main Level Overview
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Bedroom 3

Linen

Hallway

Linen bifold door
1'4" x 6'8"
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Bathroom      

  Pitcure Window
  3' x 1'
  Base Height 5' 

 
Garage

Bedroom 2
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Family Room/Kitchen
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Living Room

Laundry Room (below)

  

 Laundry Cabinet 
• 2'1" x 5'4"
• 3' high
• remove SF area behind to YES
• remove LF area behind to YES
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Stairs 1
  Staircase

• No. of risers 6
• total rise 3' 4 1/2"

  North wall set to Missing above stairs
  Landing

• base and top height 13' 3/4"
• tread base height 3' 4 1/2"

  Ceiling
• type: Box
• base height 16' 5 1/4" top height 13' 5"

Stairs 2
  Staircase

• No. of risers 9
• total rise 5' 3"
• tread base height 3' 4 1/2" 

  West and North wall set to Missing above stairs

  Ceiling
• type: Box
• base height 13' 3/4" top height 7' 9 3/4"

Stairs are NOT a subgroup of the Living Room.

Deck
  Exterior Stairs are 3'4" x 4'5"

•  Floor Height is 3'6"
•  Relation to Level: Below
•  Total Rise: 3'
•  # of risers - 4
•  Railing/Balustrade - Yes

     22'10" x 7'9"
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Master Bedroom and Master Bath

 

Vanity

  Vanity 2'1" x 5'
• default 3' tall
• remove SF area behind to YES
• remove LF area behind to YES

His and Hers are 
subrooms of the 
Master Bedroom 
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Second Level Overview
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Roof Sketch

Instructions: For the roof estimate, open a new project in Xactimate and name it L2-ROOF, followed by 
your initials; for example, L2-ROOF-JMS. Go directly to Sketch. Choose the UTOR8X_AUG13 price list, 
if prompted. Leave all Sketch properties at the default setting unless otherwise specified.

Roof Overview

 
Dormers
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	�Practical Lab—Scope

Interior Scope Lab

Now that you have completed the Kimball Sketch, use Estimate Items in Xactimate to enter the line items. 
Pay close attention to the following details:

  All line items should be added through Estimate Items in Xactimate.
  All subrooms (subgroups) should be included with the main area of the room when calculating quantities 

unless otherwise specified in the scope notes.
  All items are of average grade quality unless otherwise specified. 

Instructions: Enter the following in the Claim Info tab:

  UTOR8X_AUG13
  6.85% Tax rate
  10% O&P
  $500 Deductible – across all coverages 

Instructions: Enter the following line items in Estimate Items:

Living Room

1. Remove and Replace ½" drywall - hung, taped, floated, ready for paint on the walls and ceiling. 
2. Seal/prime then paint the walls and ceiling (2 coats). 
3. Seal stud wall for odor control - all walls. 
4. Seal floor (or ceiling) joist system on the floor.
5. Remove and Replace crown molding - 2 ¼" stain grade around the perimeter of the ceiling. 
6. Stain and Finish crown molding around the perimeter of the ceiling. 
7. Remove and Replace 2 ¼" baseboard stain grade around the perimeter of the floor. 
8. Stain and Finish baseboard around the perimeter of the floor. 
9. Remove and Replace carpet pad on the floor. 

10. Remove and Replace high grade carpet on the floor. 

Kitchen

1. Remove and Replace ½" drywall - hung, taped, floated, ready for paint on the walls. 
2. Seal/prime then paint the walls (2 coats). 
3. Stain and Finish cabinetry - upper - inside and out - 11 LF. 
4. Stain and Finish cabinetry - lower - inside and out - 17 LF. 
5. Remove and Replace countertop - Granite or Marble - 17 SF. 
6. Remove and Replace vinyl cove 6" wrap around the perimeter of the floor minus 17 LF.
7. Remove and Replace underlayment - ½" particle board on the floor for vinyl sheet goods. 
8. Replace high grade vinyl floor covering (sheet goods) on the floor. Add this item through sketch using  

graphical estimation. (Roll direction should run Left to Right. Leave all Sketch flooring settings at their  
defaults). 
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Family Room

1. Remove and Replace ½" drywall - hung, taped, floated, ready for paint on the walls. 
2. Seal/prime then paint the walls (2 coats).
3. Remove and Replace crown molding - 2 ¼" stain grade around the perimeter of the ceiling.
4. Stain and Finish crown molding around the perimeter of the ceiling. 
5. Remove and Replace chair rail - 3 ¼" stain grade around the perimeter of the floor. 
6. Stain and Finish chair rail around the perimeter of the floor. 
7. Remove and Replace baseboard - 2 ¼" stain grade around the perimeter of the floor. 
8. Stain and finish baseboard around the perimeter of the floor. 
9. Custom Cabinet (MISC Item): 

• Replacement cost total: $2400
• Materials: $1000, Retail Labor: $1400
• Add an Attachment Note: This is a custom cabinet.

Master Bedroom

1. Remove and Replace ½" drywall - hung, taped, floated, ready for paint on the walls. 
2. Seal/prime then paint the walls (2 coats). 
3. Seal stud wall for odor control - all walls. 
4. Replace visqueen vapor barrier on the floor. 
5. Remove and Replace high grade carpet pad on the floor. 
6. Remove and Replace high grade carpet on the floor through the Estimate Items tab (add 15% waste  

using the Waste tool). 

Master Bathroom

1. Remove and Replace ½" water rock or greenboard - hung, taped, floated, ready for paint on the walls   
and ceiling. 

2. Seal/prime then paint (2 coats, 2 colors) the walls and ceiling. 
3. Remove and Replace tile base around the perimeter of the floor. 
4. Remove and Replace High grade tile floor covering on the floor minus the tub SF. 
5. Activate the Plumbing Macro graphically from the Sketch Tab. 

Laundry Room

1. Remove and Replace ½" drywall - hung, taped, floated, ready for paint on the walls and ceiling. 
2. Seal then paint (2 coats) on the walls and ceiling. 
3. Remove and Replace vanity - 5'4" LF. 
4. Remove and Replace countertop - Granite or Marble - 11 SF. 
5. Remove and Replace high grade tile floor covering on the floor minus floor area of the cabinet. 

Bedroom 2

1. Remove and Replace carpet pad on the floor. 
2. Remove and Replace carpet high grade on the floor. Add this item through Sketch using graphical  

estimation (Roll direction runs Left to Right. Leave all Sketch flooring settings at their defaults).  
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Roof Scope Lab

Now that you have completed the Roof Sketch, use Estimate Items in Xactimate to enter the line items. Pay 
close attention to the following details:

  All line items should be added through Estimate Items in Xactimate.
  All subroofs (subgroups) should be included with the main area of the roof when calculating quantities 

unless otherwise specified in the scope notes.
  All items are of average grade quality unless otherwise specified. 

Instructions: Enter the following in the Claim Info tab:

  UTOR8X_AUG13
  6.85% Tax rate
  0% O&P
  $500 Deductible – across all coverages 

Instructions: Enter the following line items in Estimate Items:

Roof

1. Remove and replace Laminated - comp. shingle rfg. - w/felt on the F4 section of the roof only. 
2. Add 5% waste to the replacement cost of the shingles. 
3. Add an attachment note indicating that 5% has been added for waste. 
4. Remove and Replace sheathing - plywood - 1/2" CDX on the F4 section of the roof only. 
5. Replace 6 roof vents - turtle type - metal - on the roof. 
6. Remove and replace 3 pipe jacks - flashing - on the roof. 
7. Remove and replace valley metal in the valleys of the F4 section of the roof only. 
8. Replace drip edge on the F4 section of the roof only. 
9. Remove and Replace 40' of 5" aluminum gutter/downspout on the roof. 
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	�Practical Exam 

Practical Exam Overview

  The Practical Exam section tests your knowledge of what you sketched and scoped in the Lab.
  In the real exam, the Lab will not be available while you are taking the Practical Exam. Acquire your 

answers directly from your Xactimate estimate.
  You will be given 35 fill-in-the-blank questions. It is not important to list units of measure such as SF, LF, 

EA in any of your answers. If your answer has a decimal point, please record it rounding to the nearest 
one-hundredth of a decimal point (e.g., 123.45).

Instructions: Complete the following.

Section 1 of 7: Build a Medium Interior Sketch

1. What is the total amount of square yards of floor area in the Kitchen? __________
2. What is the square footage of the reference area in the Master Bathroom? __________
3. What is the total wall opening square footage in the 2-car garage? __________
4. What is the total square footage of walls and ceiling in the Living Room including the coat closet? _____
5. What is the square footage of wall area below stairs 2? __________
6. What is the total square footage of floor in the Master Bedroom? __________
7. What is the total amount of square footage of walls and ceiling in the Master Bathroom? __________

Section 2 of 7: Medium Interior Sketch Settings 

8. What is the total wall area square footage being deducted in the Living Room? __________
9. What is the square footage of walls and ceiling in the Kitchen? __________

10. What is the square footage of walls and ceiling in the Master Bedroom not including the Closets? _____
11. What is the total lineal footage of the Perimeter of the Ceiling in the Kitchen? __________
12. What is the square footage of walls and ceiling above stairs 1? __________
13. What is the total lineal footage around the perimeter of the floor in the Master Bathroom? __________

Section 3 of 7: Build a Medium Roof Sketch

14. What is the total number of squares on the entire Roof? __________ 
15. What is the total hip length on the entire Roof? __________
16. What is the total roof perimeter of the entire Roof? __________
17. What is the total Valley length of the entire Roof? __________
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Section 4 of 7: Medium Interior Scope Line Items

18. What is the total RCV amount to stain and finish the upper cabinetry in the Kitchen? __________
19. What is the total RCV amount to remove and replace the vinyl cove wrap in the Kitchen? __________  
20. What is the unit price to stain and finish the chair rail in the Family Room? __________ 
21. What is the total RCV amount to seal/prime then paint the walls and ceiling in the Living Room? _________
22. What is the waste percentage of carpet being replaced in Bedroom 2? __________ 
23. What is the unit price to remove and replace the vanity in Laundry Room? __________ 
24. What is the total RCV amount of carpet being replaced in Living Room including the coat closet? 

_________

Section 5 of 7: Medium Roof Scope Line Items

25. How many squares of shingles were replaced on the F4 Roof slope? __________ 
26. What is the unit price for valley metal on the Roof? __________  
27. What is the total RCV amount of sheathing being replaced on the Roof? __________ 
28. What is the total RCV amount of gutter/downspout on the Roof? __________ 

Section 6 of 7: Pricing Line Items and Estimate Reports for Medium Interior

29. What is the unit price for the carpet pad in the Living Room? __________  
30. What is the unit price of the underlayment in the Kitchen? __________ 
31. What is the Material Sales Tax amount for the Kimball Estimate? __________ 
32. What is the total Net Claim amount for the Kimball Estimate? __________

Section 7 of 7: Pricing Line Items and Reports for Medium Roof Estimate

33. In the Summary for Dwelling, what is the Line Item Total amount for the roof estimate? __________  
34. In the Summary for Dwelling, what is the Net Claim amount for the roof estimate? __________
35. In the Summary for Dwelling, what is the Material Sales Tax for the roof estimate? __________
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	�Knowledge Exam 

Knowledge Exam Overview

  The Knowledge Exam section tests your knowledge of basic functionality in the Xactimate system.
  When you take this portion of the exam online, this section is timed. 
  For the test questions below, circle the correct answer. 

1. When working on multiple estimates in the same city/state/zip, you can set up Project Loss Defaults for  
that city/state/zip to save time?
a. True
b. False

2. Where in Xactimate can you go to change the default wall thickness for all future estimates?
a. Print Options
b. Document Modules
c. Preferences within an estimate
d. Control Center/Preferences

3. This is a shortcut used in Model Statements to pre-fill data that has already been recorded in an estimate.
a. Macro
b. Shortcut
c. Token
d. Hot Key

4. Which of the following is not an option through the Contact Manager?
a. Users
b. Companies
c. References
d. Contacts

5. You can data transfer an estimate via XactAnalysis to another Xactimate user without knowing their   
XactNet address?
a. True
b. False

6. The only way to update your Xactimate version is through a disc?
a. True
b. False

7. The ability to merge data already saved from your contact manager directly into an estimate does not  
exist?
a. True
b. False

8. Xactimate can be viewed in English and printed in a different language?
a. True
b. False
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9. Which of the following is not an option from the Projects tab?
a. Re-price a project
b. Duplicate a project
c. Edit the name of a project
d. Merge Projects 

10. Which of the following is not a wall type option for stairs?
a. Missing above stairs
b. Missing (end to end)
c. Missing below stairs
d. Partially missing above stairs

11. The loss recap automatically updates from an estimate?
a. True
b. False 

12. When using the Custom staircase tool, after clicking once, the RED measurement indicates what?
a. The total run of the staircase
b. The total rise of the staircase
c. The riser height of the stair
d. The tread overhang of each stair

13. This tool allows you to change the direction that the sloped or peaked ceiling is running?
a. Reference line
b. Copy from underlay
c. Vertex
d. Orientation

     
14. When adding a new level, how many feet will sketch add or subtract from the previous level?

a. 8
b. 10
c. 9
d. 12

15. In Sketch, the keyboard shortcut for resetting your visible windows is CTRL + SHIFT + R?
a. True
b. False

16. There is no way to re-organize the members of the Grouping pane in Estimate Items?
a. True
b. False

17. Which of the following are Roof Variables?
a. F, SQ, HIP, VAL, R, P
b. RAF, HIP, VAL, P, R
c. SF, SQ, HIP, VAL, R, P
d. F, SQ, SF, HIP, VAL, R
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18. An alternate method of estimating for a loss can be done from the Sketch Tab.
a. True
b. False 

19. Draw lines to match the following Staircase Variable to its correct definition.
 Description               Variable

a. Tread Count     F
b. Wall and Ceiling Area Above Staircase   TC
c. Wall Area Below Staircase    WC
d. Floor Area Above Staircase    PCBS
e. Perimeter of Ceiling Below Staircase   WBS

20. You can add line items while viewing your sketch in 3D mode?
a. True
b. False

21. When using subvariables, what room number does Xactimate assign to the main area of the room?
a. 1
b. 3
c. 0
d. 2

22. It is possible to add a line item for tile floor covering at the same time as adding a reference area?
a. True
b. False

23. Which of the following columns in the Estimate Items/Quick Entry window allow you to track who   
entered the line item?
a. Owner Column
b. Employee Name
c. User Column
d. Use Column

24. If the activity of an item is changed, the unit price for the item does not change?
a. True
b. False

25. __________ are those additional activities, such as labor or material assumption, which may be required  
to complete a task.
a. Components
b. Project Management
c. Supporting Events
d. Items

26. To keep the ridge from shifting when modifying a single rafter length on a gable roof, use the following  
tool:

 a.   Snap Grid
 b.   Roof Locks
 c.   Reference Line
 d.   Shift + Ctrl
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27. This view tool allows you to view the overlay of carpet and vinyl once those items are graphically placed  
in the room.
a. Floor Direction
b. Flooring Orientation
c. Flooring Overlay
d. Flooring Footings

 
28. Which of the following are options for adding new grouping members in the grouping window?

a. Insert, Append, Inject
b. Insert, Append, Add
c. Append, Insert, Attach
d. Attach, Append, Intercept

29. You can Re-sequence line numbers from the Estimate Reports window prior to printing out a report?
a. True
b. False

30. After selecting ____ images per page to print in the Estimate Reports window, the program defaults to 
print the image detail on a separate page?

 a.   2
 b.   1
 c.   4
 d.   10

	�Scope Lab—Answer Key

KIMBALL ESTIMATE

Living Room Line Items
       1. Remove and Replace ½" drywall - hung, taped, floated, ready for paint on the walls and ceiling.  
 DRY ½ (&) (WC)
       2. Seal/prime then paint the walls and ceiling (2 coats).  PNT SP (+) (WC)
       3. Seal stud wall for odor control - all walls.  PNT SWALL (+) (W)
       4. Seal floor (or ceiling) joist system on the floor.  PNT JST (+) (F)
       5. Remove and Replace crown molding - 2 ¼" stain grade around the perimeter of the ceiling.  
 FNC CWN<+ (&) (PC)
       6. Stain and Finish crown molding around the perimeter of the ceiling.  PNT CWNS (+) (PC)
       7. Remove and Replace 2 ¼" baseboard stain grade around the perimeter of the floor.  FNC B+ (&) (PF)
       8. Stain and Finish baseboard around the perimeter of the floor.  PNT BS (+) (PF)
       9. Remove and Replace carpet pad on the floor.  FCC PAD (&) (F)
     10. Remove and Replace high grade carpet on the floor.  FCC AV+ (&) (F*1.15)

Kitchen Items
       1. Remove and Replace ½" drywall - hung, taped, floated, ready for paint on the walls.  DRY ½ (&) (W)
       2. Seal/prime then paint the walls (2 coats).  PNT SP (+) (W)
       3. Stain and Finish cabinetry - upper - inside and out - 11 LF.  PNT UPS (+) (11)
       4. Stain and Finish cabinetry - lower - inside and out - 17 LF.  PNT LOWS (+) (17)
       5. Remove and Replace Countertop - Granite or Marble - 17 SF.  CAB CTGM (&) (17)
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       6. Remove and Replace vinyl cove 6" wrap around the perimeter of the floor minus 17 LF.  
 FCV COVE> (&) (PF-17)
       7. Remove and Replace underlayment - ½" particle board on the floor for vinyl sheet goods.  
 FCV UL1/2 (&) (F)
       8. Replace high grade vinyl floor covering (sheet goods) on the floor - add this item through sketch using  
 graphical estimation (Roll direction should run Left to Right. Leave all Sketch flooring settings at their  
 defaults).  FCV AV+ (+) 
 Carpet seams:

 
Family Room Line Items

       1. Remove and Replace ½" drywall - hung, taped, floated, ready for paint on the walls.  DRY ½ (&) (W)
       2. Seal/prime then paint the walls (2 coats).  PNT SP (+) (W)
       3. Remove and Replace Crown molding - 2 ¼" stain grade around the perimeter of the ceiling.  
 FNC CWN<+ (&) (PC)
       4. Stain and Finish crown molding around the perimeter of the ceiling.  PNT CWNS (+) (PC)
       5. Remove and Replace chair rail - 3 ¼" stain grade around the perimeter of the floor.  
 FNC CHR>+ (&) (PF)
       6. Stain and Finish chair rail around the perimeter of the floor.  PNT CHRS (+) (PF)
       7. Remove and Replace baseboard - 2 ¼" stain grade around the perimeter of the floor.  FNC B+ (&) (PF)
       8. Stain and finish baseboard around the perimeter of the floor.  PNT BS (+) (PF)
       9. Custom Cabinet (MISC Item):  CAB MISC (+)

• Replacement cost total: $2400
• Materials: $1000, Retail Labor: $1400
• Add an Attachment Note: This is a custom cabinet.

Master Bedroom Line Items
       1. Remove and Replace ½" drywall - hung, taped, floated, ready for paint on the walls.  DRY ½ (&) (W)
       2. Seal/prime then paint the walls (2 coats).  PNT SP (+) (W)
       3. Seal stud wall for odor control - all walls.  PNT SWALL (+) (W)
       4. Replace visqueen vapor barrier on the floor.  INS VIS (+) (F)
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       5. Remove and Replace high grade carpet pad on the floor.  FCC PAD (&) (F)
       6. Remove and Replace high grade carpet on the floor through the Estimate Items tab (add 15% waste  
 using the Waste tool).  FCC AV+ (&) (F*1.15)

Master Bathroom Line Items
       1. Remove and Replace ½" water rock or greenboard - hung, taped, floated, ready for paint on the walls   
 and ceiling. DRY 1/2WR+ (&) (WC)
       2. Seal/prime then paint (2 coats, 2 colors) the walls and ceiling.  PNT SP+ (+) (WC)
       3. Remove and Replace tile base around the perimeter of the floor.  FCT B (&) (PF)
       4. Remove and Replace high grade tile floor covering on the floor minus the tub SF.  
 FCT AV+ (&) (F-SFA2)
       5. Activate the Plumbing Macro graphically from the Sketch Tab. 

Laundry Room Line Items
       1. Remove and Replace ½" drywall - hung, taped, floated, ready for paint on the walls and ceiling.  
 DRY ½ (&) (WC)
       2.   Seal then paint (2 coats) on the walls and ceiling.  PNT SP (+) (WC)
       3. Remove and Replace vanity - 5'4" LF.  CAB VAN (&) (5,4)
       4. Remove and Replace countertop - Granite or Marble - 11 SF.  CAB CTGM (&) (11)
       5. Remove and Replace high grade tile floor covering on the floor minus floor area of Vanity.  
 FCT AV+ (&) (F-SFB1)

Bedroom 2 Line Items
       1. Remove and Replace carpet pad on the floor. FCC PAD (&) (F)
       2. Remove and Replace carpet High grade on the floor - add this item through Sketch using graphical  
 estimation (Roll direction runs Left to Right. Leave all Sketch flooring settings at their defaults).  
 FCC AV+ (&) 
 Carpet Seams:
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Roof Line Items
       1. Remove and replace Laminated - comp. shingle rfg. - w/felt on the F4 section of the roof only.  
 RFG 300 (&) (F4SQ)
       2. Add 5% waste to the replacement cost of the shingles. 
       3. Add an attachment note indicating that 5% has been added for waste. 
       4. Remove and replace sheathing - plywood - 1/2" CDX on the F4 section of the roof only.  
 RFG SH1/2 (&) (F4SF)
       5. Replace 6 roof vents - turtle type - metal - on the roof. RFG VENTT (+) (6)
       6. Remove and replace 3 pipe jacks - flashing - on the roof. RFG FLPIPE (&) (3)
       7. Remove and replace valley metal in the valleys of the F4 section of the roof only.  RFG VMTL (&) (27)
       8. Replace drip edge on the F4 section of the roof only. RFG DRIP (+) (31.08)
       9. Remove and Replace 40' of 5" aluminum gutter/downspout on the roof. SFG GUTA (&) (40)

	�Practical Exam—Answer Key 

Section 1 of 7: Build a Medium Interior Sketch
       1. What is the total amount of square yards of floor area in the Kitchen?  20.35 SY
       2. What is the square footage of the reference area in the Master Bathroom?  18.20 SF
       3. What is the total wall opening square footage in the 2-car garage?  153.67 SF
       4. What is the total square footage of walls and ceiling in the Living Room including the coat closet?    
 899.06 SF
       5. What is the square footage of wall area below stairs 2?  112.33 SF
       6. What is the total square footage of floor in the Master Bedroom?  271.18 SF
       7. What is the total amount of square footage of walls and ceiling in the Master Bathroom?  536.05 SF

Section 2 of 7: Medium Interior Sketch Settings 
       8. What is the total wall area square footage being deducted in the Living Room?  65.84 SF
       9. What is the square footage of walls and ceiling in the Kitchen?  533.66 SF
     10. What is the square footage of walls and ceiling in the Master Bedroom not including the Closets?    
 705.71 SF
     11.   What is the total lineal footage of the perimeter of the Ceiling in the Kitchen?  58.15 LF
     12.  What is the square footage of walls and ceiling above stairs 1?  84.31 SF
     13.   What is the total lineal footage around the perimeter of the floor in the Master Bathroom?  47.41 LF

Section 3 of 7: Build a Medium Roof Sketch
     14.   What is the total number of squares on the entire Roof?  25.67 SQ     
     15.  What is the total hip length on the entire Roof?  136.25 FT
     16.   What is the total roof perimeter of the entire Roof?  268.19 FT
     17.   What is the total Valley length of the entire Roof?  89 FT

Section 4 of 7: Medium Interior Scope Line Items
     18.   What is the total RCV amount to stain and finish the upper cabinetry in the Kitchen?  $360.47
     19. What is the total RCV amount to remove and replace the vinyl cove wrap in the Kitchen?  $228.94
     20. What is the unit price to stain and finish the chair rail in the Family Room?  $.85
     21. What is the total RCV amount to seal/prime then paint the walls and ceiling in the Living Room?    
 $658.40
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     22. What is the waste percentage of carpet being replaced in Bedroom 2?  10.05%
     23. What is the unit price to remove and replace the vanity in Laundry Room?  $125.20
     24. What is the total RCV amount of carpet being replaced in Living Room including the coat closet?    
 $1902.14

Section 5 of 7: Medium Roof Scope Line Items
     25. How many squares of shingles were replaced on the F4 Roof slope?  4.33 SQ
     26. What is the unit price for valley metal on the Roof?  $3.97
     27. What is the total RCV amount of sheathing being replaced on the Roof?  $753.78
     28. What is the total RCV amount of gutter/downspout on the Roof?  $188.50

Section 6 of 7: Pricing Line Items and Estimate Reports for Medium Interior
     29. What is the unit price for the carpet pad in the Living Room?  $.62
     30.  What is the unit price of the underlayment in the Kitchen?  $1.80
     31. What is the Material Sales Tax amount for the Kimball Estimate?  $805.32
     32. What is the total Net Claim amount for the Kimball Estimate?  $30515.02

Section 7 of 7: Pricing Line Items and Reports for Medium Roof Estimate
     33. In the Summary for Dwelling, what is the Line Item Total amount for the roof estimate?  $2440.98
     34. In the Summary for Dwelling, what is the Net Claim amount for the roof estimate?   $2008.46
     35. In the Summary for Dwelling, what is the Material Sales Tax for the roof estimate?  $67.48

	�Knowledge Exam—Answer Key

       1.   When working on multiple estimates in the same city/state/zip, you can set up Project Loss Defaults for  
 that city/state/zip to save time.
 a.   True
 b.   False

       2.   Where in Xactimate can you go to change the default wall thickness for all future estimates?
 a.   Print Options
 b.   Document Modules
 c.   Preferences within an estimate
 d.   Control Center/Preferences

       3.   This is a shortcut used in Model Statements to pre-fill data that has already been recorded in an estimate.
 a.   Macro
 b.   Shortcut
 c.   Token
 d.   Hot Key

       4.   Which of the following is not an option through the Contact Manager?
       a.   Users
 b.   Companies
 c.   References
 d.   Contacts
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       5. You can data transfer an estimate via XactAnalysis to another Xactimate user without knowing their   
 XactNet address.
 a.   True
 b.   False

       6. The only way to update your Xactimate version is through a disc.
 a.   True
 b.   False

       7. The ability to merge data already saved from your contact manager directly into an estimate does not  
 exist.
 a.   True
 b.   False

       8. Xactimate can be viewed in English and printed in a different language.
 a.   True
 b.   False

       9. Which of the following is not an option from the Project tab?
 a.   Re-price a project
 b.   Duplicate a project
 c.   Edit the name of a project
 d.   Merge Projects

      10. Which of the following is not a wall type option for stairs?
 a.   Missing above stairs
 b.   Missing (end to end)
 c.   Missing below stairs
 d.   Partially missing above stairs

      11. The loss recap automatically updates from an estimate.
 a.   True
 b.   False

      12. When using the Custom staircase tool, after clicking once, the RED measurement indicates what?
 a.   The total run of the staircase
 b.   The total rise of the staircase
 c.   The riser height of the stair
 d.   The tread overhang of each stair

      13. This tool allows you to change the direction that the sloped or peaked ceiling is running?
 a.   Reference line
 b.   Copy from underlay
 c.   Vertex
 d.   Orientation

      14. When adding a new level, how many feet will sketch add or subtract from the previous level?
 a.   8
 b.   10
 c.   9
 d.   12
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      15. In Sketch, the keyboard shortcut for resetting your visible windows is CTRL + SHIFT + R.
 a.   True
 b.   False

      16. There is no way to re-organize the members of the Grouping pane in Estimate Items.
 a.   True
 b.   False

      17. Which of the following are Roof Variables?
 a.   F, SQ, HIP, VAL, R, P
 b.   RAF, HIP, VAL, P, R
 c.   SF, SQ, HIP, VAL, R, P
 d.   F, SQ, SF, HIP, VAL, R

      18. An alternate method of estimating for a loss can be done from the Sketch Tab.
 a.   True
 b.   False

      19. Draw lines to match the following Staircase Variable to its correct definition.
 Description               Variable
 a.   Tread Count      F        (D)
 b.   Wall and Ceiling Area Above Staircase   TC     (A)
 c.   Wall Area Below Staircase    WC    (B)
 d.   Floor Area Above Staircase    PCBS (E) 
 e.   Perimeter of Ceiling Below Staircase   WBS  (C)

      20. You can add line items while viewing your sketch in 3D mode.
 a.   True
 b.   False

      21. When using subvariables, what room number does Xactimate assign to the main area of the room?
 a.   1
 b.   3
 c.   0
 d.   2

      22. It is possible to add a line item for tile floor covering at the same time as adding a reference area.
 a.   True
 b.   False

      23. Which of the following columns in the Estimate Items/Quick Entry window allow you to track who   
 entered the line item?
 a.   Owner Column
 b.   Employee Name
 c.   User Column
 d.   Use Column

      24. If the activity of an item is changed, the unit price for the item does not change.
 a.   True
 b.   False
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      25. __________ are those additional activities, such as labor or material assumption, which may be required  
 to complete a task.
 a.   Components
 b.   Project Management
 c.   Supporting Events
 d.   Items

      26. To keep the ridge from shifting when modifying a single rafter length on a gable roof, use the following  
 tool:
 a.   Snap Grid
 b.   Roof Locks
 c.   Reference Line
 d.   Shift + Ctrl

      27. This view tool allows you to view the overlay of carpet and vinyl once those items are graphically placed  
 in the room.
 a.   Floor Direction
 b.   Flooring Orientation
 c.   Flooring Overlay
 d.   Flooring Footings
 
      28. Which of the following are options for adding new grouping members in the grouping window?
 a.   Insert, Append, Inject
 b.   Insert, Append, Add
 c.   Append, Insert, Attach
 d.   Attach, Append, Intercept

      29. You can re-sequence line numbers from the Estimate Reports window prior to printing out a report.
 a.   True
 b.   False

      30. After selecting ____ images per page to print in the Estimate Reports window, the program defaults to   
 print the image detail on a separate page?
 a.   2
 b.   1
 c.   4
 d.   10
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